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AUTOSAR Overview --- Classic Platform

- AUTOSAR (Automotive Open System Architecture) Is a
standardization initiative of leading automotive manufacturers and
suppliers, founded in 2003.

- The idea behind AUTOSAR is to avoid continually re-developing the
same or similar software components.

- The AUTOSAR concept is based on modular components with
defined interfaces.

- Hardware and software are decoupled from one another.
- Reduced development effort and costs and improved quality.
- Re-use of development methods and tools.

-
| 2 |

CONFIDENTIAL & PROPRIETARY | 2



AUTOSAR Overview --- Classic Platform

- The AUTOSAR Classic Platform architecture distinguishes on the
highest abstraction level between three software layers which run on
a microcontroller: application, runtime environment (RTE) and basic
software (BSW).

- The application software layer is mostly hardware independent.

- Communication between software components and access to BSW via RTE.

-The RTE represents the full interface for applications.

-The BSW is divided in three major layers and complex drivers.
- Services, ECU (Electronic Control Unit) abstraction and microcontroller abstraction.

- Services are divided furthermore into functional groups representing the infrastructure
for system, memory and communication services.
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AUTOSAR Overview --- Adaptive Platform

- The AUTOSAR Adaptive Platform is based on POSIX operating
systems. The primary motivations are autonomous driving, Vehicle-
to-X (V2X) applications and the growing external networking of
vehicles (Connectivity).

-
| 2 |
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< > AUTOSAR Classic Release 4.4.0 ) < > AUTOSAR Adaptive Release 19.03 ) < > AUTOSAR Acceptance Test Release 1.2 >
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MCAL Overview

- MCAL (MicroController Abstraction Layer) Is a very important part of
AUTOSAR. If you are not familiar with AUTOSAR/MCAL, you can
think of it as the driver layer you usually write. The difference is that
MCAL following AUTOSAR standard(Include CDD).

-
| 2 |
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MCAL Overview --- NXP MCAL Package Content

Name 0- AUTOSAR_MCAL 5P| CodeCoverage Summary.ssx
0= AUTOSAR_MCAL_SPI_MisraReportxls
0= AUTOSAR_MCAL_SPI_ProfileReport.xlsx
spi 0= AUTOSAR_MCAL_SPI_RamSizeReport.ulsx
wdg 0= AUTOSAR_MCAL_SPI_SizeReportxls
0 AUTOSAR_MCAL Quality Matrixxlsx 9) AUTOSAR_MCAL_SPI_SummaryTestReport.html

n AUTOSAR_MCAL_SummaryTestReport.html [a- AUTOSAR_MCAL_SPI_TraceabilityMatrix.xls

B AUTOSAR_MCAL SummaryTestReport html %) AUTOSAR_MCAL_SP1.TS.pdf
B AUTOSAR_MCAL_SPI_VSMDReport.hitml

eclipse ¢ plugins

532K14X_MCALL 3 RTM_1_0_0_Sample_Application Spi_TS_T40D2M10I0RD

B GettingStarted.htm Wdg_TS_T40D2M10I0RD

 license.dat

W S32K14X_MCAL 4.3 RTM_1.0.0.exe

i 532K14X_MCAL 4.3 RTM_1.0.0_QualityPackage.zip
A 532K14X_MCAL_4.3_RTM_1.0.0_ReleaseNotes,pdf
0= S32K14X_MCAL_4.3_RTM_1.0.0_SCR.xlsx

W S32K14X_MCAL_4.3_SAFETY_PACK_RTM_1.0.0.exe

pwm

FESOUrce

license.txt Wdglf_T5_T40D02M10I0R0
B 532K14X_MCAL4_3_RTM_1_0_0_ReleaseMotes.pdf | com.freescaletools.tresos.xpath.jar
ﬁ' Uninstall.exe
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AUTOSAR FAQ

- Where can | get these material?
hitps://www.autosar.org (AUTOSAR)
https://www.nxp.com/autosar (MCAL)
- Is it free or need charge?
AUTOSAR :Free

MCAL: Depends on platform
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https://www.autosar.org/
https://www.nxp.com/autosar

Development Environment

- Hardware

-MTRDEVKSPNK144: S32K144
Development Kit for 3-phase PMSM

- Software
- S32K14X MCAL4 3 RTM_ 1 0 O
= (We also provide SDK version)
- Lib
- Math and Motor Control Library
- Tuning

- MCATSW: Motor Control Application
Tuning (MCAT) Tool

- Configuration&&Debug Tool
- EB Tresos Version 24
- S32 Design Studio
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https://www.nxp.com/support/developer-resources/evaluation-and-development-boards/automotive-motor-control-development-solutions/arm-based-solutions-/s32k144-development-kit-for-3-phase-pmsm:MTRDEVKSPNK144
https://www.nxp.com/webapp/sps/download/license.jsp?colCode=MTRDEVKSPNK144_SW&appType=file2&DOWNLOAD_ID=null&lang_cd=en
https://www.nxp.com/support/developer-resources/run-time-software/automotive-software-and-tools/automotive-math-and-motor-control-library-set:AUTOMATH_MCL
https://www.nxp.com/products/processors-and-microcontrollers/power-architecture-processors/mpc5xxx-55xx-32-bit-mcus/ultra-reliable-mpc56xx-32-bit-automotive-and-industrial-microcontrollers-mcus/motor-control-application-tuning-mcat-tool:MCATSW

System Overview --- System Diagram
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System Overview --- Sequence Diagram

FTM3 MOD -J-=-=======-= it i i ittty =
(2000 ticks) : : :
FTM3_COV -foveen-- .. SR ; R VS . R i - AR T " -
b 100us P ; ;
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CPU FOC_ FOC_
Calculation Calculation
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Modules Configuration --- MCU

- Core Clock && System Clock && FTM: 80MHz

- Bus Clock && ADC && SPI: 40MHz

- Enable Run mode

- Enable ADCO_SE5 and ADC1_SE15’s Interleave
- Set PDB as ADC'’s trigger source

- FIRC Enable(recommend), enable PLL

- SOSC Range: High

- Osclillator Gain: High

-
| 2 |
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Modules Configuration --- MCU

- McuRunClockConfig

Name @ |McuRunClockConfig |

SOSC Range Select

Run Pre Div System Clock Frequency (Hz) (1000 -> 160000000) B 1.6E8

+ HIGH_FREQ_RANGE

Run Core Clock Frequency (Hz) (1000 -> 80000000) 5 |8.0E7
Run System Clock Frequency (Hz) (1000 -> 80000000) & {8.057
Run Bus Clock Frequency (Hz) (1000 -> 48000000) B {4,057
Run Flash Clock Frequency (Hz) (1000 -> 26670000) B i2,057
Run System Clock Select @ (SPLL
PTB1 to ADCO_SE4 and ADC1 SE15 [ & v
* McuAdcOptionsConfiguration
Name @ IMcuAchptionsConfiguration ]
ADC1 pre-trigger source B [PDB_PRE_TRIGGER vl 8~

ADC1 software pre-trigger source B [SW_PRE_TRIGGER_DISABLE v] 8-

ADC1 trigger source B IPDB vl Fa

ADCO pre-trigger source B IPDB_PRE_TRIGGER V] ! 4d

ADCO software pre-trigger source B [SW_PRE_TRIGGER_DISABLE v] 8 -

ADCO trigger source B IPDB vl g

Software Trigger to TRGMUX m ] e~

High Gain Oscillator Select Il & v -
"J e McuClockReferencePoint
Ind... & Name @ McuClockR... @ Mcu Clock Frequ...
v &~ | 0 & MauClockReferencePoint SYS CLK [ 8.0E7 | RUN_SYS_CLK
3 J s 1 & McuClockReferencePoint BUS CLK (e 4.0E7 = RUN_BUS_CILK
2 & MauClockReferencePoint ADCO le 4.0E7 ' ADCO_CLK
v J R 3 & MauClockReferencePoint ADC1 le 4.0E7 © ADC1_CLK
4 = McuClockReferencePoint_FTMO le 8.0E7 ./ FTMO_CLK
"J 4~ 5 & McauCockReferencePoint_FTM3 le 8.0E7 = FIM3_CLK
S J S -~ 6 & MauClockReferencePoint_LPIT e 4000000.0 - LPIT_CLK
7 & MauClockReferencePoint_LPSPIO @ 4.0E7 . LPSPIO_CLK
8 & McuClockReferencePoint_FIRC le 48E7 . FIRC_CLK
* McuFIRCClockConfig

Name e |McuFIRCClockConfig

FIRC under MCU control

FIRC Frequency (48000000 -> 60000000)
FIRC Div2 Frequency (1 -> 48000000)
FIRC Div1 Frequency (1 -> 48000000)
FIRC Enable

FIRC Divider 2 (0 -> 64)

FIRC Divider 1 (0 -> 64)

FIRC Frequency Range
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FTM3 NI

POBT CHO

'HENA

; | INPUT _DISABLED
, [INPUT DISABLED

ADCT_COCOA

FTM3_INT

'R

FTM3_INT

Modules Configuration --- MCL

- This is a CDD module, responsible for

TrgMux and DMA module’s configuration

- In this system, we use trgMux module to

debug

- Enable TrgMux Function
- Set FTM3 _INT as TrgMux

PDBO0&&PDB1’s input

- Set FTM3_INT as TrgMux OUT2’s input
- Set PDB1 _CHO as TrgMux OUT3'’s input
- Set ADC1 _COCOA as TrgMux OUTG6'’s

Input

-
| 2 |
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Modules Configuration --- Port

EXTAL/XTAL 2 :PTB7/PTB6

JTAG TCLK/TDI/TDO/SWD 4 : PTC4/PTC5/PTAL10/PTA4

SPI SCK/SIN/SOUT 3: PTB2/PTB3/PTB4

UART1 RX/TX 2 PTC6/PTCY

TRGMUX OUT2/0OUT3/0OUT6 3 : PTD1/PTAO/PTE15
FTM(PWM) CHO~CH5 6 : PTB8~PTB11&PTC10&PTC11
ADCO_SE4/ADC1_SEG6/SE7/SE15 4 : PTBO/PTB12/PTD4/PTB1

GPIO 12 : PTA2/A3/B5/15/C12/13/D0/2/14~16/E10
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irtPin

Modules Configuration --- Port

me = | PortPin_50_PTC12

oneral - Pcr Calc: CalcNum * =2 + PInNum
PortPin Passive Filter Enable [ PortPin Direction | ’ Example -
PortPin Mode Changeable [ g PTC12 2* +12 — 76
PortPin Id B |28 v | 4
PortA 0
tPin M ' -
PortPin Mode % |GPIO K PortB 1
PortPin DSE 3 Low_drive_strength PortC 2
PortPin PE 4 | PullDisabled .|, PorD 3
PortE 4
PortPin PS 3 PullDown
PortPin Direction B |FGHT_F'IN_II"-.I v | &
PortPin Initial Mode .3 PORT_GPIO_MODE

PortPin Level Value & |FDHT_F'IN_LE\-’EL_LGW v | & CONFIDENTIAL & PROPRIETARY | 19



Modules Configuration --- Dio

- This module responsible for setting the GPIO function, like the
direction: input or output; default level: High or Low and so on.

- Each Pin belongs to different Port need create independent group.

General | DicPort . Published Information

Mame g |DioPort A

B DioPor
. ® Name General - DioChannel | DioChannelGroup General IETEEE . DioChannelGroup
0 & DioPort A 7] 0 - i
1 & DioPort B ' 1 Dio Port Id {0 -> 4} @ rﬂ M@ DioChann
" ]!uPurl_C z Ind.. & MName B Dio Channel 1d
= Dot ; H Properties = 0 © DioChannel A2 E 2
4 & DioPort E 4 ) i - :
Properties for DioPortld 1 & DioChannel A3 3
Description Mumeric identiffer of f
Information used for confighration
= Porta=0
Problems . PortB=1
PostBuildVariantConditions - PortC=2
» PortD=3
Comments « PortE=4
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Modules Configuration --- ICU

- The time measurement of Cyclic, high level, low level.
- Edge detection and notification.

- Edge counting and timestamp.

- Wakeup interrupt.

- Gpio interrupt belongs to the second function.

- We have three GPIO need enable interrupt function:
-PTE10: GD3000 INT
-PTC12: Button 1
-PTC13: Button 2
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Modules Configuration --- ICU

Name @ Iluﬂmul_ﬂ
General
lcu |
Name & ||l:l.l MName g |lcuPortE MName g |buPort C lewChannelid 8 .I.'I o | 4~
General lcuChannel leuftm lcuPort lcul pi Port Modules IcuPortChannels lcuHwiP « PORT v|€~
® lcuFtmChannel Ref o
M lauPort O feuPortChannels ® | portch 1Ref P Fe— o
d =% cuPortChanne s Meufeu/louCon lcuPort_EflcuPort 10
Ind. & Name / Ind. & Name ® Port Channel @ fuioy 'gSet/ =) -
0 < leuPort E 0 & laPoriCha_ = CH 12 ¥ cul pitChannelRef @
1 & lewPort C 1 & lewPortCha.. = CH 13 .
[

lcuDMAChannelEnable »

lcuDMAChannelReference &

General | lcuChannel . lcuFtm  lcuPort lculpit lculptrr© | lcuHwinterruptConfiglist Published Information uDefadiStartEdge + [ICU_RISING FDGE s
8 luChannel lcuMeasurementMode 4 MODE SIGNAL EDGE_DETECT ~ | / =
Ind.. & Name E larChe. 2 lwHwlP B oD @ lwD. B lowDefauliStartBdge lcuOverflowNotification o NULL_PTR
0 & larChannel O = 0 = PORT £ S @ ICU RISING_EDGE o
1 B8 1 B 1 = PORT im & % ICU_RISING EDGE lculockableChanned » lcuWakeupCapability § [ | #
2 & luChannel 2 = 2 ZPORT %7 & s ICU_RISING_EDGE * lcuSignalEdgeDetection

B yame o louSignalEdgeDetection

I|r1hignalwmufh-minn i .GDEDUO_Im_Noﬁfy o g~
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Modules Configuration --- PWM

- Enable related channel(Total 6 channels): FTM3 _CHO ~ FTM3_CH5
- Edge configuration: Independent mode

- Align mode: Center align mode
- Cycle: 50us
- Delay: 32 Cycle
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Modules Configuration --- PWM

29 & PwmH.. = PWM FTM 2 FAULT ISR i

30 & PwmH_ = PWM_FTM_3_CH.0 ISR BC

31 & PwmH.. = PWM_FTM_3 CH 1 I5R B

32 & PwmH.. = PWM_FIM 3 CH 2 ISR 3

33 & PwmH_ & PWM_FTM_3_CH 3 ISR BC

34 = PwmH.. = PWM FITM 3 CH 4 ISR B

36 & PwmH_ & PWM_FTM_3_CH 6 ISR B
| PmethhanneIs
... & Name % Ftm Hardware C.. F Edge configuration setti.. 3 Phase.. [
0 © PamfimChannels 0 [ FIM3.CHO |- INDEPENDENT |
1 & PwmMmChannels 2 = FTM_3 CH 2 = INDEPENDENT
2 = PwmFtmChannels_4 = FTM_3 CH 4 = INDEPENDENT
3 & PwmFtmChannels_1 [ FTM_3_CH_1 ‘o INDEPENDENT
4 = PwmFmChannels_3 E FIM_3.CH3 ‘o INDEPENDENT
5 = PwmFtmChannels 5 = FTM_3 CH.S 'p INDEPENDENT

Ftm Modules . PwamMmChannels

Ftm Hardware Module

Prescaler

PwmPrescaler Alternate

FTM Module dodk selection

Ftm Module's Channels Alignment

End cyde reload

Reload Frequency

B Deadtime Counter (0 -> 1023)

® DeadTime Counter Prescaler

Pwm Background Debug Mode configuration

Pwm Fault Funtionality and Clear Mode

CONFIDENTIAL & PROPRIETARY

= FIM3 viB~
B PRESC 1 v g
& PRESC 1

B PWM _SYSTEM (LOCK vidw
| PWM _CENTER_ALIGNED v |4 v
3 M7~ Half cyde reload R
- LDFQ EACH3? &~
= 2 |cv

= PRESC_1 v &
= CNT_ON_OUTPUTS ON v &~

5 FLICTRL DISABLED
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Modules Configuration --- ADC

- In ADC module, it not only configure the ADC but also PDB

- Enable the following channel: ADCO _4/ADC1 6/ADC1 /7/ADC1 15
- Enable PDB Trigger function

- Set the PDB delay time(by manual code): 2000/1000/0/2000

- Enable ADCO_COCO&&ADC1 COCO Iinterrupt

- Group Access Mode: Single mode

- Conversion Mode: One Shot mode

- Transfer Type: Interrupt

- Resolution: 12 Bits

-
| 2 |

CONFIDENTIAL & PROPRIETARY | 25



Modules Configuration --- ADC

General - AdcChannel AdcGroup Name @) AdcHwUnit_0

I 1 Name ..alﬁ-dcl-hﬂl..l'nitj I

General[AdcChannel ™ AdcGroup General AdcChannel - AdcGroup

Adc Transfer Type - 'g[)(;_m“mup] v]
|
+ ADC_ALTCLKY @ AdcChannel Dnaﬁdcfl'lannel
Adc Hardware Unit 4 |aDC v] Ind.. & Name @ AdcL. B Adcl : . o Mame . j fde Ll; - AdeHa
& AdcChannel = AN_G
. : 0 & AdcChannel 4 = 05 AN4
Ade Logical Unit Id L - - - . . 1 & AdeChannel 7 0 1 = AN_T
_ _Germd_ﬁdcl-lwuit McFmﬂateCooﬂgMdnmm Published Infor 2 & AdcChannel 15 4 2 = AN 15
Adc Voltage Reference Selection 3 VREFH_VREFL w - -
] el B nﬂdr.lnt-:nupt
Ackc Resvoksts r Ind.. & Name = Adec Interrupt N... fude Interrupt |
- e 5 BTS2 - 0 @ Adcinterrupt 0 & ADCO_COCO
) - . - 1 & Adcinterrupt_1 = ADC1 COCO
General -~ AdcGroupDefinition Aduthannel[lelaﬂ AdcGroup AdcGroup
Ade Group Access Mode B |A,DC_ACCE55_MODE_5|NGI_E 'v| & Name = |Adcl_GroupD Marme E|ﬁdc1_&o:pﬂ |
Adec Group Conversion Mode 4 [ADC_CONV_MODE_ONESHOT | 6 General | AdcGroupDefinition AdcChannelDelay General AdcGroupD=finition AdcCharnelDelay
Ade Group Id ML ~| @
_ _ B hdcsroupDefiniticn 2 nnelDelary
Ade Group Trigger Source , |aDc_TRIGG_SRE_HW v| & - —
- = - Ind_ @ AdcGroupDefinition Ind. E AdcC.
® Adc Group Notification 4 |Ade1_Group0_Callback |5~ 0 @ fAdc/Adc/AdcConfigSet/AdcHwlnit 1/AdcChannel 7 0= i
_ _ . 1 @ jAdcjAdc/AdcConfigSet/AdcHwlnit 1/AdcChannel 6 1 @™ 1000
Ade Group Streaming Number Samples B |1 v| # 2 & sadgAdyAdcConfigSet/AdcHwunit 1/Adcd 115 2 B 2000
Ade Group Without Interrupts © ] &= Ade Group In Bac
Name & |Add)_Groupd MName & |Add) Greup)
Ade Group Uses Channel Delays W [« & ) -
B AdcGroupDefinition B8 AdcChannelDelay
Ind. € AdcGroupDefmition Ind. 2 AdcC.
0 MdgAdc/AdcConfigSet/AdcHwUnit 0/AdcChannel 4 0 = 2000
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Modules Configuration --- SPI

- Master mode

- Speed: 2M

- Polarity: LOW

- Shiftedge: Rise edge/Leading
- Clock Idle Level: LOW

- DataWidth: 8Bit

- Transferwidth: 1Bit

- TransferStart: MSB
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Modules Configuration --- SPI

Name @ |SpiChannel_0 | SpiExternalDevice
;G-enar;l"" Mame @ |5piEﬂturnulDwicu_0
General -
SpiChannelld & 0 v| M.
SpiChannelTypea L V| g SpislaveModea B [ ] &
SpiDataWidth (8 -> 32) 1C | & - SpiBaudrate (4 -= 2B000000) 5 2000000.0 Vl g -
SpiTransferWidth + '1 w | @ SpibaudrateAlternate (4 -> A0000000) @ 100000.0
m 3 1 SpiCsidentifier g PCSO |#§ -
SpiEbMaxLength (0 -> 65535) % | SpiCsPolarity b LOW v| &~
spilbNBuffers al V| &~ ® <piCsSelection L €S VIAGPIO R
SpiTransferStart s MSB v| oo SpiDataShiftEdge ™ LEADING vl &F -
Name @ |5pﬂub_ﬂ SpiEnableCs H v
General - SpiChannelList| SpiHwUnit 4 €SI80 |4
SpiShiftClockidlelevel o LOW v| &
® SpiHwUnitsynchronous |5wcunomous :
SpiTimeClk2Cs (0 -» 0.0001) = | 1.0E-6 | -
® SpilobEndNotification 3 |GD3nm_5piﬂ_lnbEndNnﬂfy |
SpiTimeCs2Clk (0 -> 0.01) 5 | 1.066 | # =
® SpilobstartNotification  » [GD3000_Spi0_JobStartNotify | '
SpiTimeCs2Cs (0 -> 0.01) 5 1.0E-6 | # =
e . _ .
SpiPhyUnitMapping @ LPSPLO SpiCsCantinous i  TRUE v o
SpiPhyUnitMode % SPILMASTER SpiByteSwap & FALSE L | oo
SpiPhyUnitSync & [+l # -
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Manual Code --- ADC
- New file: Adc_Cbk.c

SS/F1le: Adc_Cbk.c

P vold AdcO0_Group0_Callback(void) /* Include channel 4 */f

3| 1

4 S /Do nothing

| ]

7 vold Adcl_Group0_Callback(void) /* Including channel &,7,15 =/

8 1

o Dio_WriteChannel (DioConf_DioChannel_DioChannel_D2,5TD_HIGH) ;
10 Ftm3_DisableInitTrig();
11 Adcl_ConvEndFlag = TRUE;

2}
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Manual Code --- ADC

- Modify(Add the code which in red rectangle): Adc_Pdb Irg.c

#ifdef ADC_UNIT_O_PDB_ERR_ISR_USED

extern voi1d PdbO0_Irqg_Notify(void);

ISR(Adc_Pdb_ChannelSequenceErrorQ)

{
Adc_Pdb_ChannelSequenceError{0U);

PdbO_Irg_Motify();

]
#gendi f

#1fdef ADC _UNTT PDE_ERR_T5R_LUSED

extern void Pdbl_Irq_Notify(void);

ISR(Adc_Pdb_ChannelSequenceErrorl)

{
Adc_Pdb_ChannelSequenceError{1U);

Pdbl_TIrqg_Notify();

T
#enda
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Manual Code --- ADC
- Modify(Remove one line, line number:558): Adc_Pdb.c

1 /* Configure the period of counter =/
2 Jf** @violates @ref Adc_Pdb_c_REF_3 cast from unsigned long to pointer */
i J/** @violates @ref Adc_Pdb_c_REF_7 A cast should not be performed between a pointer

tyvpe and an integral type. */
4 | //REG_WRITE32 (PDB_MOD_REG_ADDR32 (Unit), ul6PeriodPdb);
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Manual Code --- FTM

- New file: Ftm3.c

1| //Ftm3.c

2  extern INLINE void Ftm3_EnableInitTrig(void)

3 {

4 REG_BIT_SET32(FTM_EXTTRIG_ADDR32 (PWM_FTM_3), FTM_EXTTRIG_INITTRIGEN_MASK_U32):

5| }

7 extern INLINE void Ftm3_DisableInitTrig(void)

8| {

g REG_BIT_CLEAR32(FTM_EXTTRIG_ADDR32(PWM_FTM_3), FTM_EXTTRIG_INITTRIGEN_MASK_U32):
10 | }
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Manual Code --- PDB
- New file: Pdb.c

1 //Pdb.c

25 extern INLINE void Pdb_ClearIntFlag(uint8 channel)

2  extern INLINE void Pdb_EnableInt(uint8 channel) 26 | §
3 | { 27 /* Clear PDBO timer interrupt flag */
& /* Enable pdb interrupt */ 28 REG_BIT_CLEAR32(PDB_SC_REG_ADDR32(channel), PDB_INTERRUPT_FLAG_MASK_U32);
5 REG_BIT_SET32(PDB_SC_REG_ADDR32(channel), PDB_INTERRUPT_ENABLED_U32); 29 | }
6|} 30
7 31  extern INLINE uint8 Pdb_GetErrorFlag(void)
8 extern INLINE void Pdb_SetModvalue(uint8 channel,uint32 value) 32| £
9| { 33 return Pdb_SeqErrFlags;
10 /= Set pdb modulus value */ 34  }
11 REG_WRITE32(PDB_MOD_REG_ADDR32(channel), value); 35
12 | 3} 36 extern INLINE void Pdb_SetErrorFlag(Pdb_SeqErrEType error)
13 37°]
14  extern INLINE void Pdb_SetIdlyvalue(uint8 channel,uint32 value) 38 Pdb_SeqErrFlags [= (uint8)(error);
1s | § 39 Ftm3_DisableInitTrig();
16 /* Set pdb interrupt delay value */ 40 MotorsSM_SendEvent (MOTORSM_EVENT_ID_FAULT);

REG_WRITE32(PDB_IDLY_REG_ADDR32(channel), value); 1 |}
18 42
;: } 13  extern INLINE void Pdb_ClearErrorFlag(void)
20 extern INLINE uint32 Pdb_GetIntFlag(uint8 channel) 4 | {
21| { 45 Pdb_SeqErrFlags = 0;

46 | }

22 return (REG_READ32(PDB_SC_REG_ADDR32(channel))&PDB_INTERRUPT_FLAG_MASK_U32);
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Manual Code --- PDB
- New file: Pdb_Cbk.c

J/Pdb_Cbk.c
/* Pdb0_SeqErr_MNotify(5equence error notify) is before Pdb0_Irg_Notify =/
extern INLINE woid PdbO_SeqErr_Notify(void) //TODD: Weed a parameter to indicate which 24
channe]l 25  /* Pdbl_Irg_Notify is after Pdbl_SeqErr_Notify(Sequence error notify) */
{ 26  extern INLINE woid Pdbl_Irg_MNotify({voi1d)

Pdb_SetErrorFlag(PDB_SEQ _ERR_PDBO); 27 | {
1 28 /= PDBl1 timer overfTlow interrupt *,/

29 if (0 '= Pdb_GetIntFlag(1))

/* Pdbl_SeqErr_MNotify(5equence error notify) is before Pdbl_Irg_Notify =/ 30 {
extern INLINE void Pdbl_SeqErr_Notify({void) 31 /= Clear PDBl1 timer interrupt flag =/
{ 32 Pdb_ClearIntFlag(l);

Pdb_SetErrorFlag(PDE_SEQ_ERR_PDEL); 33 if (PDB_SEQ_ERR_NONE == Pdb_GetErrorFlag(})
1 34 {

35 /* Enable FTM initialization trigger to trigger ADC modules every second

J* Pdb0O_Irg_Notify 1s after Pdb0O_SeqErr_Notify(Sequence error notify) */ PWM cycle (10kHz). =/
extern INLINE void PdbO_Irg_Notify(void) 36 /* Ignore if there are PDBs sequence errors */
{ 37 Ftm3_EnableInitTrig();

/= PDBO timer overflow interrupt =/ 38 ¥

if (0 1= Pdb_GetIntFlag(0)) 39 1

i a0 | }

J* Clear PDBO timer interrupt flag */f
Pdb_ClearIntFlag(0);

ol
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Manual Code --- PWM

- Modify(struct:Pwm_Ftm_ModuleConfig_PB,the 61" member):
Pwm_Pbcfg.c

1 J/** @brief FTM_3_COMBIME register */
2 (FTM_COMBIME_SYNCEMNZ_ENABLE_U32 | FTM_COMBIME_SYNCEN1_EMNABLE_U32 |
FTM_COMBINE_SYNCENO_ENABLE_U32 | ((uint32) 0)),

1 J/*=* @brief FTM_3_COMBIME register =/
2 (FTM_COMBINE_DTENZ_ENABLE_U32 | FTM_COMBINE_COMPZ2_COMPLEMENT_U32
| FTM_COMBIME_DTEN1_ENABLE_U32 | FTM_COMBINE_COMP1_COMPLEMENT_U3Z2

| FTM_COMBINE_DTENO_ENABLE_U32 | FTM_COMBINE_COMPO_COMPLEMENT_U32
| FTM_COMBINE_SYNCENZ_ENABLE_U32 | FTM_COMBINE_SYNCENL_ENAELE_U32 |
FTM_COMBINE_SYNCENO_ENABLE_U32 | ((uint32) 0)),
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Manual Code --- Startup&&Link&&Middleware

- Startup && Link file: S32DS auto-generate

- Nvic: interrupt management, priority setting

- CircularQueue: queue

- FOC(Field-Oriented Control): Motor control algorithm
- GD3000: GD3000 driver

- Key: Key input event management

- Led: Led control

- Measure: DC-BUS Voltage/Current, phase current
- Motor: Motor driver, speed control

- MotorSM: Motor control main state machine

- UsrCtr: User control information setting

- Walit: Software delay
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EB_Project

S32DS Proiect
.settings
Debug

FreeMASTER _control

generated
include
MCAL
Middleware
Project_Settings
Src

D .cproject

D .gitignore

D .project

! . EB tresos 24.0.1 - workspace: C:
File Edit Search Project Windo

@ v £ &g v

2 Project Explorer &
v B B Project
v @ ECUC (ARM, S32K14X)

& Adc (V1.0.0, AS4.3.1)
® Base (V1.0.0, AS4.3.1)
# Dio (V1.0.0, AS4.3.1)
® EcuM (V1.0.0, AS4.3.1)
® Gpt (V1.0.0, AS4.3.1)
® lau (V1.0.0, AS4.3.1)

& Md (V1.0.0, AS4.3.1)
® Mcu (V1.0.0, AS4.3.1)
® Os (V1.0.0, AS4.3.1)

# Port (V1.0.0, AS4.3.1)
® Pwm (V1.0.0, AS4.3.1)
® Resource (V1.0.0, AS4.3.1
& Spi (V1.0.0, AS4.3.1)
config

> output

Code Integration --- Overview

-« The main modules: Adc Pwm
Mcl

- The “generated” folder is auto
generated by EB_Project

- The "MCAL” folder is the static
code of modules

L |
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Code Integration --- Packing MCA
- S32DS: Window -> Preferences -> SD

_to SDK
K Management -> Add

.€ - 532 Design Studio fD”RM

Processor Expert Wind Help * Preferences
rE Y Y @ New Window | SDK Management
Install/Update A ' v
P Editor > NXP Licenses ame o
CircularQueue.c R s Processor Expe FreeMaster K.. 2.0.0
. 81 de_f c[nEElEILE Remote Systen FreeMaster S... 2.0.0
KEAZ128 1.00
82 Adc ¢ . Run/Debug
—_" b
83 Sth View SDK Managem KEAZN64 100
: KEAx_AMMC... 1.1.8
84 /* Er Show C-SPY View > Team .
Terminal KE AI_!‘!’\M MC- 1 1 -B
85 Pdb_E Perspective > Validation KEAx AMMC.. 1.1.8
* VA Yo KEAX AMMC.. 1.1
86 /* Se S <l >
87 Pdb © Navigation >
¥ g @
88 /* S Preferences |\e '
Rg Pdh <

Type

Contributed
Contributed
Contributed
Contributed
Contributed
Contributed
Contributed
Contributed

-

S5DK description

FreeMASTER 5erial Communi...
FreeMASTER Serial Communi..,
sSample Drivers for KEAxx (E...
Sample Drivers for KEAsx (E...
Automotive Math and Motor...
Automotive Math and Motor...
Automotive Math and Motor...
Automotive Math and Motor...

0K
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Remove
Clone from qit
Impaort...
Fvrmrt

Cancel
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Code Integration --- Packing MCAL to SDK

= MNew SDK . ‘ = Change SDK Location >
New SDK Set SDK files location
@ SDK location must not be empty Y Selected folder contains more than 1000 files.

It will take a lot of time to populate them.

Name: S32K14X_MCAL

Version: |d-3.‘l_HTM_1 0.0 P1 (®) Define new variable S32K14X_MCAL_4.3.1_RTM_1.0.0 P1_PATH
Description: | SW32K14-SMCL431-RTMC-1.0.0_P1 Location: CANXPVAUTOSAR\S3ZK14X_MCAL4_3_RTM_1_0_O\eclipse\plugins

Enviranment ‘\
Variable |_4.3.1_RTM_1.0.0_P1_PATH| (Not set) Variable... a Browse.. I

Lﬂcatic:n:| Change... () Select system variable
Sources Headers Binaries Resources Linker LD file * |' Location:

Name Sel Co )] q| 0K | Cancel
@ oK Cancel
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Code Integration --- Packing MCAL to SDK

* New DK X ‘ Headers Binaries Resources Linker LD files 4| *  Sources

New SDK Name Select Copy » Name

+ plugins + plugins

_Binaries Resources Linker LD files 4 | * Resources Linker LD files |Deﬁned symbols 1 | r

Sel Co # | Defined symbols o ol 3

Enter SDK name, version, description and

location v Ade_TS_T40D2M10I0R0 v Adc TS_T40D2M1010R0
» generate PB » generate PC
Name: | S32K14X_MCAL | » generate.PC © nclude @
Version:  |4.3.1_RTM_1.0.0_P1 | v oc r Adch _
Description: | SW32K14-SMCL431-RTMC-1.0.0_P1 | Adcc h o Adc_Adc12bsarv2h * | DefinggPymbats
Enviconment Adc_Adc12bsarvaf N o Adc_Adci2bsarv2_Cigixh *
Variable |S32K14X MCAL 43.1 R | User's) Adc_Adc12bsdiv_Irq.c “" pe Adc_EnvCfg.h o AUTOSAR_OS_NOT_USED
d A3 RTM_| | ) + ® Adc_lpw.h .
CANXPAAUTOSAR + x Adc_Pdb.h x
Location: \332K14}$_MCAL413_R'[M_ Change... 3 o Adc_Reg_eS:.-s_Addesaruzx
L (nachpse\phigin > CarTS_T40D2M10I0RO y Adc_Reg eSys Pdbh x y
Sources Headers Binaries Resources Linker LD files 4 | ’
urces Headers Binaries Resources Linker LOYfiles 4 | ' SourcesBinaries Resources Linker LD files 4 | @ “ l Cancel
Name Select Copy A [
~ plugins Name Select Copy A~ Name Sel Co ~ 7
v Adc_TS_T40D2M10I0R0 ¥ plugins + plugins
> generate_PB v Adc TS_T40D2M1010R0 v Ade_TS_T40D2M10I0R0
> generate PC | 7 generate_PB .
[ » generate_PC v include -
Adcc v sic * Adch L
Adc_Adci12bsarvi.c x Adc.c - Adc_Adc12bsarv2 h - &l
Adc AdciZbsanv2 Irge % . Adc_Adc12bsarv2.c * Adc_AdciZbsarv2 Cigixh + | ¥
Adc_lpw.c X - 1| Adc_AdciZbsave ige T Adc_EnvCfg h + |#
Adc_Pdb.c x Adc_lpw.c - Adc_lpw.h + |+
Adc_Pdb Irg.c x Adc_Pdb.c = Adc_Pdb.h LA
» Can_TS_TAOD2M10I0R0 < Adc_Pdb_lrg.c “* Adc_Reg_eSys_Adcl2bsarve¥ | ¥
> Can_TS_T40D2M10I0R0 v | Adc_Reg_eSys_Pdbh % le.u El o

Cance
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Code Integration --- New Project(S32DS

- Se

ect MCAL in SDKs items

» workspaceS32DS.ARM.2018.R1 - C/C++ - Motor/src/main.c - S32 Design

File Edit Source Refactor Navigate Search Project Run Processor Expe

New

Open File...
£2 Open Projects from

Makefile Project with Existing Cc
& C++ Project
& C Project

€ C/C++ Project

Alt+Shift+N > &

Close Ctrl+W = SO :
|." S32DS Application Project l:}
Close All Ctrl+Shift+W = g3ops Library Project
= S32DS Application Project O X ‘t from Example
Create a S32 Design Studio Project w:532D5 Application:Project o X
New $320D5S Application Project New S32DS Project for S32K144
Select required cores and parameters for them.
Project name:
MCAL _Test a
Project Name MCAL _Test
[l use default location Core [ Cortex-M4F
C:\Users\NXF50137\workspaceS32DS.ARM 2018 R1\MC Browse, Library Newlib i
1/O Support Debugger Console v
Processors : ToolChain Selection: FPU Support Hardware : -mfloat-abi=hard v
— Language C v
type filter text CoreKind Name Toolchain SDKs e L
& Family KEA Al | M4 Cortex-M  ARM Bgga-Metal 3. v Debugger PE Micro GDB server "b
& Family S32Vv 6
v @ Family S32K1xx
¥ S32K144 e Description :
# S32K116 GCC toolchain v.6.3 is selected
¥ S32K118 -
8 S32K142 o < Back ey Cancel
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Code Integration --- Project Properties

- Header file include and Macro define

- M1: Select Project and right click -> Properties

- M2: Menu -> Project -> Properties

- M3: Dashboard -> Project settings/Build settings

- Then, C/C++ Build -> Settings -> Tool Settings -> Standard S32DS C
Compiler -> Preprocessor/Includes

-
| 2 |
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Code Integration --- Project Properties

[ Project Explorer &
~ | Motor: Debug

i Binaries
» #l Indudes
» 5 MCAL

# Middleward
» & Project_Setf
» @ generated

2% von

Mew

Go Into

Compare With
Configure

Source

# includa

Properties 1

# Dashboard &

* Project Creation
[ 532D5 Application Project
& 53205 Library Project

= Build/Debug
% Build (Al

« Clean (All)

# Debug

* Settings

€ Project settings
% Build settings

: Debug settings

type filter gext

» Resourc
Builders
C/C++ Build

<

Build Variables
Environment

Logging

Settings
Tool Chain

» C/C++ General
EmbSys Register View

Project References
Run/Debug Settings

Search | Project IRun Processor Ex

Eiggi Open Project
= Close Project

® Tool Settings # Build Steps

Build Artifact [ Binary Pars

Build All
Build Configurati]
Build Project
Build Working S¢| ¥
Clean...
" Build Automatic3

o

Build Targets

C/C++ Index
Generate Process

Synchronize Prodpssor

Include paths (-1)
"${ProjDirPath}/include"
"${ProjDirPath
"${ProjBirPath}/output/include”
*$1ProjDirPath}/MCAL/Adc/include”
"${ProjDirPath}/MCAL/Base/include”
"${ProjDirPath}/MCAL/Can/include”
"${ProjDirPathl/MCAL/Canlf/include"

2 Cross Settings

(2 Target Processo
& Standard 532D¢
(& Dialect
(& Preprocessef?
2 Includes
ik

& Optimization

Properties I 1

4ttings

¥ Tool Settings

Configuration: |Debug FLASH [ Active ] v

# Build Steps

Manage Configurations

Build Artifact b Binary Parsers @ Error | 4

\ (2 Cross Settings

(2 Target Processor

[_] Do not search system directories (-nost

[ ] Preprocess only (-E)

® Standard $32DS C Compiler|

Defined e 2§

2 Dialect

N\

ARMCM33 DSP FP

\\ 2 Preprocessor A

& Includes

USE_SW_VECTOR_MODE
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Code Integration --- Compile Resource Configurations

- Add/Remove source file(*.c) to/from compile target

- M1(Add/Remove): Select Project and right click -> Build
Configurations Explorer

- M2(Add/Remove): Select File/Folder and right click -> build path ->
Add to/Remove from -> Debug/Release/Debug RAM

- M3(Remove): Select File/Folder and right click -> Resource
Configurations -> Exclude from Build

-
| 2 |
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Debug/Tuning --- Run

- Enable 12V Power Plugin, Led in yellow(default)

- Press SW2/SW3, Led flash in yellow(calibration) and then turn to
green(align)

- Red color means error happened, press SW2 and SW3 at the same
time to clear error

- In running mode, press SW2/SW3 to speed up/speed down
- In running mode, press SW2 and SW3 at the same time to stop

-
| 2 |
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Debug/Tuning --- FreeMASTER/MCAT

Speed control, show real speed/current dynamicly and many other
useful function

B ] S32K_PMSM_Sensorless.pmp - FreeMASTER
File Edit View Explorer Project Tools Help

: = e (D] & e B B

PMSM FOC sensorless contiifal
= == Control Motor 1: PMSM Tuning Mode: Expert |v |

o2 Infroduction Parameters Current Loo Speed Loo| Sensors Sensoriess Control Struc ut File App Control
£ Speed e N e T |

EHg E

‘Tahoma - V1O

Motor Control Application Tuning Tool

>
~+=1DQ Welcome to MCAT
-5 Faults & Trips Ramp Pl AW LPF Plwi AW VS
wWRES dqg |uR=a SVM _T
=15 Sensors/Actuators P \I/ l/ | [ — .?. — B = :1
=--"% Position/Speed Sptional Cptonal RN
: wFeEeK dq JFBcK BFBC" jFecK
=--®% OpenlLoop - Scale o
4 MCAT ap
= Speed teFBCK position
z Dl e w,g=57| _Angle sensor =
¥ JABC 4 4 - Tracking 5 N
SEnsor Observer
¥ Position iteh [+ kMAF IR rec |
SW Switch u |
o wetst| _Ana |« Back EMF =
=" V0|tage $oesr L Oksories Observer |e—>" "
=
UdC Motor Control Application Tuning tool
2 uDOReA v The MCAT is intended to be used as a tool for real-time tuning and debugging of PMSM industrial applications. Parameters of the
< > Field Oriented Conirol structure are estimated by MCAT based on the dynamic requiremenis and system parameters. Right Pi

controller parameters lead to desirable behavior of the motor quantities. The static configuration of the tuned system can be stored in
an external header file

Connecfing and tuning a new electric drive setup becomes easier with a Control Structure tab which offers the possibility to split the
=N | control structure and allows controlling the motor at different levels of cascade control structure

semiconduc

control pages I

| Value Unit
? [RDm]

CONFIDENTIAL & PROPRIETARY | 46

Name
|Speed Re(:luire(g1



Appendix

- NXP_AUTOSAR_MCALFFAINEFEES|S S32K14xE . pdf
- NXP_MCALZEHIHELS, S32K1E . pdf

- EB_Tresos A\ | Ji&ma.pdf

- MCALECETES: REAIEHIXNEB A KA. pdf

- S32DSEiE B 2HISDK.pdf

. (FF3S32DSEEMCAL.pdf
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